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Address Books & Contacts

5 Address Books & Contacts
All graphics related to Microsoft in this book is in compliance with Microsoft guidelines and thus permitted by Microsoft.

Objectives:
By the end of this section you will be able to:
•

Identify different address books

•

Create a personal address book

•

Create a distribution list

•

Create contacts

•

E-mail a contact

•

Find and edit a contact

•

Flag a contact

•

Add a vCard to out going messages

Download free eBooks at bookboon.com
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Address Books and Contacts

The Address Book is a collection of address books provided by Microsoft Outlook, Microsoft Exchange Server, or Internet
directory services, depending on how you have set up Outlook. You can use the Address Book to look up and select names,
e-mail addresses, and distribution lists when you address messages. When you type a name in the To, Cc, or Bcc box of
an e-mail message, Outlook automatically checks to see if the name you typed matches a name in the Address Book. If
there is a match, the name is resolved and you can send the message. If there is no match, Outlook prompts you for more
information by way of the Check Names dialog box.

5.2

Global Address Book

The Global Address List is a feature of Microsoft Exchange Server that contains all user and distribution list e-mail
addresses in your organisation. The administrator creates and maintains this address book. It can also contain public
folder e-mail addresses.

)To display the global address book:
Menu

•

Click Tools, then Address Book or Click address book icon

on the standard toolbar.



•

Click the drop-down arrow in the Show Names from the: section and select Global address List.

)To find a name in the global address book:
Menu

•

Display the Global Address List as shown above.

•

Enter the name that you would like to find in the Type name or Select from list section.

Download free eBooks at bookboon.com
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5.3

Address Books & Contacts

Right-click the name, and then click Properties to display the details about the selected name.

Personal Address Book

A Personal Address book is a private mailing list. Personal Address Books can be created or edited by the user. Names
can be added to the Personal Address book via the Global Address List or from other electronic address books. Personal
Address books are used to create mailing lists of the people the user frequently sends messages to.

)To view the Personal Address book:
Mouse

•

Display the Address Book window.

•

Click In the Show Names from the: box.

•

Select Personal Address Book from the drop-down list.

)Add a Personal Address Book

Download free eBooks at bookboon.com
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Menu
•

On the Tools menu, click E-mail Accounts.

•

Under Directory, click Add a new directory or address book, and then click Next.

•

Click Personal address books.

•

Enter name and specify the location and click OK.

)To Remove an address book
Menu

•

On the Tools menu, click E-mail Accounts.

•

Under Directory, select View or change existing directories or address books, and then click Next.

•

Click the address book you want to delete and click Remove.

•

Click Finish.

)To add an address to Personal Address book:
Menu

•

Display the Address Book window.

Download free eBooks at bookboon.com
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•

Select the name from the appropriate address book to add to the Personal Address Book.

•

Choose File from the menu bar, Add to Personal Address Book

•

Click the right mouse button on the selected name, choose Add to Personal Address Book from the shortcut

Or
menu or click
•

on the toolbar.

To close the Address Book window, click

or press the Escape on the keyboard.

Editing a Personal Address Book
Names can be deleted from the Personal Address Book. You can also set your Personal address Book to display when
creating new mail messages.

)To delete a name from the Personal Address Book:
Menu

•

Display the Personal Address Book and select the name to delete.

•

Choose File, Delete

Download free eBooks at bookboon.com
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Or

•

Click the right mouse button on the selected name, choose Delete or press the Delete key on the keyboard.
A warning box displays.

•

Choose Yes to confirm removal of the selected name.

•

In the Inbox folder click

•

Select the name to delete.

•

Click

•

Choose Yes to confirm removal of the selected name.

Mouse
. The Address book window displays and select Personal Address Book.

on the toolbar. A warning dialog displays.

)To display the Personal Address book by default:
Menu

•

In the Address Book window, choose Tools, Options. The Addressing dialog box displays:-

Excellent Economics and Business programmes at:

“The perfect start
of a successful,
international career.”
CLICK HERE

to discover why both socially
and academically the University
of Groningen is one of the best
places for a student to be
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Options

Description

Show this address list first

Displays the address list in the active profile.

Keep personal addresses in

Displays the user’s default personal address book to add names
to.

When sending mail, check names using
these address lists in the following
order

Displays the order in which address lists are checked when
sending messages.
Moves the address list up one line in the list.
Moves the selected address list down one line in the list.

Add

Adds the selected Address list to the list.

Remove

Removes the selected Address list to the list.

Properties

Displays details for the selected address list.

•

Click the down arrow to the right of the Show this address list first box.

•

Select Personal Address Book and choose OK.

•

To close the Address Book window, choose File, Close.

•

Choose Tools, Address Book. The Address Book window opens listing the default Personal Address Book.

Download free eBooks at bookboon.com
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Creating a personal distribution list

If a user finds that they are sending messages to the same group of people regularly, a Personal Distribution List may be
created. When addressing a message to a Personal Distribution List, all individuals in the group will receive the message.
Personal Distribution List names are displayed in bold in the Personal Address Book.

)To create a Personal Distribution List:
Menu

•

In the Inbox folder, choose Tools, Address Book. The Address Book window displays.

•

Choose File, New Entry. or click

on the toolbar. The New Entry dialog box displays.



Options

Description

Select the entry type

Lists the types of entries to create.

Other Address

Used if a specific address entry type is not listed.

Personal Distribution List

Creates a single Address Book entry for a group of
recipients.

Put this entry

Indicates the location of the new Address Book entry.

In the

Displays the name of the address list where the new
entry is to be added.

In this message only

Adds the new entry to the To box in the active
message.

•

In the Select the entry type box, select Personal Distribution List.

•

In the Put this entry section, click the arrow to the right of In the.

•

Select Personal Address Book.

•

Choose OK. The New Personal Distribution List Properties dialog box displays.

Download free eBooks at bookboon.com
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Options

Description

Name

Displays the name of the Personal Distribution List. Group
names can be of any length, include spaces and can be in
upper or lowercase letters.

Add/Remove Members

Opens the Edit New Personal Distribution List members
dialog box allowing the user to select recipients from the list.

.

Download free eBooks at bookboon.com
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•

In the Name box, type a name for the group, e.g. Mailing list.

•

Choose Select Members. The Select Members dialog box displays.



Options

Description

Show names from the

Displays the required address list.

Type Name or Select from List

Type or select the required name from the list.

Members

Adds the selected member to the Personal Distribution List.

•

Select the required user names to add to the Personal Distribution List.

•

Choose Members. The selected user names are displayed in the Personal Distribution List box.

•

Repeat steps 9 and 10 to add additional user names.

•

Choose OK. The selected names display in the New Personal Distribution List Properties dialog box.

•

Choose OK. The Personal Distribution List is displayed in the Address Book.

Download free eBooks at bookboon.com
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5.5

Editing a Personal Distribution List

A Personal Distribution List can be edited to include new members or remove existing members. The distribution list
can also be renamed.

)To remove a user name:
Mouse

•

Display the required distribution list.

•

In the Personal Distribution List box, select the members to be removed.

•

Choose Remove.

•

To close the dialog box, choose Save and Close

)To rename a Distribution list:
Mouse

•

In the Inbox folder, click

.

•

Double-click on the required distribution list.

•

In the Name box, type the replacement name for the distribution list.

•

Choose OK.

)To use a Personal Distribution List:
Mouse

•

Compose a new mail message.

•

Click

•

Double-click on the required distribution list. The selected distribution list displays in the Message

. The Select names dialog box displays.

Recipients box.
•

Choose OK

Download free eBooks at bookboon.com
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Or
•

Type the name of the distribution list on the address field.

•

Complete and send the message.

5.6

Contacts

A contact is a person with whom the user communicates with on a business or personal level. Business and personal
contacts can be stored in the Contacts folder.

)To Open Contacts:
Mouse

•

In the Navigation Pane, click



Contacts displays in the Contact list. By default, the Contacts folder automatically opens in a view known as Address Cards.
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Creating a contact
The user can create contact information containing contact names, addresses and phone numbers. When a contact is created,
the user can enter new information, or they can start with a copy of information on an existing contact from the same
company and amend it as necessary. When a new contact is created, a Contact form will display with four tabs: General,
Details, journal and All Fields. The General tab is the default tab and contains fields for general information relating to
a contact, e.g. name and address. The other tabs contain fields for more specific information about a contact. Each piece
of contact information is stored in a field, however, information does not have to be entered in every field or every tab.

)To Create a New Contact’s Name and Address:
Menu

•

Choose File, New Contact

•

In the Contacts folder, choose Contacts, New Contact or click

Or

Download free eBooks at bookboon.com
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•

In the Full Name box, type the contact’s name. A full name is the first and last name for the contact, or the
first and last name plus a middle name, title and suffix, e.g. Jr.

•

To make sure the parts of a name are identified correctly, choose Full Name. The Check Full Name dialog
box displays.

•

If required, change the full name information and choose OK

Download free eBooks at bookboon.com
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Or
•

If details are correct, choose OK.

•

In the Job title box, type the contact’s job title, e.g. Managing Director.

•

In the Company box, type the contact’s company name.

•

Click the arrow to the right of Business and choose the address type, e.g. Business, Home or Other.

•

In the Address box, type the address required pressing [ENTER] after each line of the address.

•

To enter additional addresses for the contact, repeat steps 7 and 8 choosing a different address type in step 7.

Up to three addresses can be created for the contact. When an address type is selected, e.g. Home, the address assigned
to that type will automatically display.
•

To set one of the addresses to be the contact’s mailing address, display the address type required, e.g.
Business, and choose. This is the mailing address.

This address becomes the primary address that shows in most views and is used in Word 2003 mailmerges. If only one
address has been entered, that address is used as the mailing address.
•

To make sure the parts of an address are identified correctly, choose the address type required, e.g. Business,
and choose Address. The Check Address dialog box displays.

•

If required, change the address details and choose OK

> Apply now
redefine your future

- © Photononstop

AxA globAl grAduAte
progrAm 2014

Download free eBooks at bookboon.com
axa_ad_grad_prog_170x115.indd 1

19/12/13 16:36

25

Click on the ad to read more

Outlook 2003: Part II

Address Books & Contacts

Or
•

If details are correct, choose OK.

•

In the File as box, select the name or company name to display the contact under.

Company names that start with articles, e.g. “A” or “The”, are automatically displayed under the next word in the name,
e.g. “The Bar” is displayed as “Bar, The”.
•

In the Notes box, type any supplementary information required, e.g. specialises in car maintenance.

•

Click

.

)To Create a contact from an e-mail message you receive:
Mouse

•

Open the e-mail message that contains the name you want to add to your contact list.

•

In the From field, right-click the name you want to make into a contact, and then click Add to Contacts on
the shortcut menu.

)To Select a Contact:
Mouse

/HWWHU
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Click the Letter tab that the name to go to begin with Click anywhere on the contact. The name or company
name the contact is filed under highlights indicating selection.

)To Edit Contacts:
Menu

•

Select the contact to edit.

•

Choose File, Open or click the right mouse button on the contact, choose Open.

•

Edit the data as required, e.g. change the contact’s name.

•

Click

.

)To Edit Fields Directly in a Card:
Mouse

•

Click the field in the card to edit. The insertion point displays.

•

Position the insertion point and type new text required

•

Press [Delete] to delete characters to the right of the insertion point.

•

Press [Backspace] to delete characters to the left of the insertion point. New text is inserted to the left of the

Or
Or
insertion point and existing text is pushed to right.
If direct card editing is not available, it can be enabled by the user.

)To Enable Direct Card Editing:
Menu

•

Choose View, Arrange By, Current View, Customize Current View, Other Settings, then in Card body.

•

Tick Allow in-cell editing.

•

Choose OK.

Some fields cannot be edited directly in a card, e.g. the contact name in the card heading. To edit this information, the
contact must be opened.

)To Add an E-mail Address to a Contact:
Mouse

•

Create or open a contact.

•

Click

•

In the E-mail box, type the e-mail address required.

and select the address required from the list of e-mail addresses and choose OK.

Or

An Internet e-mail address consists of a user name and a domain name, with the two separated by an @ sign, e.g. if sem1o1
is the user and msn.com is the domain name the address would be semlo1@msn.com.
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To add additional e-mail addresses, click the arrow to the right of E-Mail and choose E-mail 2 or E-mail 3
and repeat step 2

•

Click

.

)To Add Phone Numbers for a Contact:
Mouse

•

Create or open a contact.

•

In the Phone Location box, select an option that describes the phone number, e.g. Business.

•

In the Phone Number box, type the phone number required.

•

For international phone numbers and automatic phone dialling use +country code (area code) local number
as the format.

•

To add additional phone numbers, in a different Phone Location box and Phone Number box repeat steps
2 and 3.

•

.

Click

Dialling notes can be included after the phone number, e.g. “ext. 2181” or “before 17:30”).

)To Add Personal Information Relating to a Contact:
Mouse

•

Create or open a contact.

•

Choose the Details tab.

•

Add the details required, e.g. Birthday.

•

Click

.
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)To Delete a Contact:
Menu

•

Select the contact to delete.

•

Choose Edit, Delete

•

Click the right mouse button on the contact to delete, choose Delete.

•

Select the contact to delete.

•

Click

Or

Mouse

5.7

.

Viewing Contacts

Outlook 2003 allows the Contacts display to be altered, using one of the following views:
Address Cards

Displays contacts on individual cards with one mailing address,
including their business and home phone numbers.

Detailed Address Cards

Displays contacts on individual cards with business and home
addresses, phone numbers and additional details.

Phone List

Displays contacts in a list with company name, business phone
number, business fax number and home phone number.

By Category

Displays contacts in a list grouped by categories and sorted by the
names the contacts are filed under within each category.

By Company

Displays contacts in a list grouped by company with job title,
company name, department, business phone number and
business fax number.

By location

Displays contacts in a list grouped by country with company name,
state, country, business phone number and home phone number.

By Follow Up Flag

(New in 2003) It is possible to flag a contact that you need to call
by specifying a date and time for Outlook to send you a reminder,
through Actions Menu, Flag for Follow Up.

)To Change View:
Menu

•

In the Contacts folder, choose View, Arrange By, Current View.

•

Choose the view required.

Mouse


•

In the Contacts folder, click the arrow to the right of

•

Select the view required.

Download free eBooks at bookboon.com

29

.

Outlook 2003: Part II

5.8

Address Books & Contacts

E-mailing a Contact

From a contact in the Contact list, Outlook 2003 can address a mail to the chosen contact.

)To Send a Mail Message to a Contact:
Mouse

•

In the Contacts folder, select the contact to mail.

•

Click

•

Click and drag the contact onto Inbox.

•

Complete the rest of the e-mail and send it.

on the standard toolbar

Or

5.9

Locating Contacts

The Advanced Find from the Menu bar can be used to quickly find contacts. This feature enables the user to search for
specific text in all fields, regardless of how they are displayed. When using the Advanced Find feature the user enters criteria
for which to base the search on. The Advanced Find dialog box contains three tabs: Contacts, More Choices and Advanced.

)To find a Contact:
Mouse

•

On the toolbar, type the
\ name of the contact you want to find in the Find a contact box
.

•

You can enter a partial name, such as Judy L, a first or last name, an e-mail alias, display as name, and
company name and press [ENTER]. To quickly open a contact you previously searched for, click the Find a
contact arrow and select a name.

•

If there are more than one occurrences of the search phrase entered, the following dialog box will be
displayed, asking you to choose a contact from the list.
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Or

•

From the Standard toolbar, click the Find button

. The following find bar opens up above the

message headers.
•

In the Look for box, type a first or last name, an e-mail alias, display as name, and company name you want
to search for in or click the arrow on the Look for box to use previous search text.

•

Click Find Now, the search takes place and the results are displayed.

)To use Advanced Find:
Menu

•

In the Contacts folder, choose Tools, and Advanced Find.

•

In the Search for word(s) box, type the text required, e.g. the name of the contact required.

•

In the In box, select the field(s) to search.

•

For the broadest search, select frequently used text fields.

•

If required, in the Time box, select the time the contact was created or modified.

Need help with your
dissertation?
Get in-depth feedback & advice from experts in your
topic area. Find out what you can do to improve
the quality of your dissertation!

Get Help Now

Go to www.helpmyassignment.co.uk for more info
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•

Choose Find Now. The results of the search are displayed in a table at the bottom of the Find dialog box.

•

To display contact details, double-click on the contact required in the table.

•

On completion, close the contact. The Find dialog box redisplays.

•

To locate additional contacts, choose New Search and follow steps 2 to 7

•

To end the search, close the Find dialog box.

Or

)To Find Contacts By Category:
Menu

•

In the Contacts folder, choose Tools, Advanced Find.

•

Choose the More Choices tab.

Options

Description

Categories

Displays a list of the categories to search. To search more than one category, separate them
with commas.

Only items that are

locates items based on whether they have been opened.

Only items with

locates items based on whether they have a file attached.
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Whose importance
is

locates items based on the importance or priority level specified.

Match case

locates items that have the exact combination of uppercase and lowercase characters the
user specified in the ‘Search for the words’ box in the Contacts tab.

Size (kilobytes)

Used to set a size comparison value, e.g. to find items smaller than 1,000 kilobytes, choose
‘less than’, and then type 1,000 in the box to the right.

•

Choose the options required, e.g. Set category to Personal.

•

Choose Find Now. The results of the search are displayed in a table at the bottom of the Find dialog box.

•

To display contact details, double-click on the contact required in the table.

•

On completion, close the contact

•

The Find dialog box redisplays.

•

To locate additional contacts, choose New Search and follow steps 3 and 4.

)To Perform an Advanced Search:
Menu

•

In the Contacts folder, choose Tools, Find, Advanced Find.

•

Choose the Advanced tab.

•

Choose Field. A list of fields displays.

•

Choose the field, e.g. All contact fields.A list of all the selected fields displays.

•

Choose the field to search, e.g. Last Name.

•

In the Condition box, specify a requirement the field must meet, e.g. Is (exactly).

•

In the Value box, type a value for the field that meets the requirement in the Condition box, e.g. Thomas.

•

Choose Add to List. Repeat steps 3 to 10 for each field required.

•

Choose Find Now.

•

The results of the search are displayed in a table at the bottom of the Find dialog box.

•

To display contact details, double-click on the contact required in the table.

•

On completion, close the contact.

•

The Find dialog box redisplays.

•

To locate additional contacts, choose New Search and follow steps 3 to 10.

Flagging Contacts
You can flag a contact to remind yourself to follow up on an issue or to indicate a request for someone else. You can also
use flags to set a reminder for the contact.

)To add a flag:
Mouse

•

In the contact, click

.

•

In the Flag to box, click the flag you want, or type your own.

•

Enter a date and time in the Due by boxes.
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)To remove a flag:
Mouse

•

In the contact, click

•

Click Clear Flag.

.

)To set a reminder for a contact:
Mouse

•

Create or open a contact.

•

On the Actions menu, click Follow Up.

•

In the Flag to list, click the setting you want.

•

In the Due by list, click the down arrow to display a calendar. Click a date on the calendar.

•

In the Time list, enter the time you want the reminder to display.

Sending contact information to others
Microsoft Outlook supports the use of vCards, the Internet standard for creating and sharing virtual business cards. You
can save a contact as a vCard and send it in an e-mail message. You can also add a vCard to your e-mail signature. When
you open a vCard, it opens as a contact item, and you can easily save it to your Contacts folder.

)To send a vCard

Brain power

By 2020, wind could provide one-tenth of our planet’s
electricity needs. Already today, SKF’s innovative knowhow is crucial to running a large proportion of the
world’s wind turbines.
Up to 25 % of the generating costs relate to maintenance. These can be reduced dramatically thanks to our
systems for on-line condition monitoring and automatic
lubrication. We help make it more economical to create
cleaner, cheaper energy out of thin air.
By sharing our experience, expertise, and creativity,
industries can boost performance beyond expectations.
Therefore we need the best employees who can
meet this challenge!

The Power of Knowledge Engineering

Plug into The Power of Knowledge Engineering.
Visit us at www.skf.com/knowledge
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Mouse
•

Click the contact you want to send as a vCard, and then on the Actions menu click Forward as vCard.

•

If the Forward as vCard command is not available, click Forward

)To save a vCard attachment to Contacts:
Mouse

•

Open the message you received.

•

Double-click the attachment to open it.

•

In the open contact, click Save and Close.

•

The information in the vCard is saved to your Contacts folder.

)To include a vCard with your e-mail signature
Mouse

•

On the Tools menu, click Options, and then click the Mail Format tab.

•

Click Create Signature.

•

Click New.

•

Select the options you want, and then click Next.

•

Under vCard options, select a vCard from the list or click New vCard from Contact.

)To create a vCard from a contact:
Mouse

•

Open the contact you want to save as a vCard.

•

On the File menu, click Export to vCard file.

•

Type a name in the File name box, and then click Save.
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6 Using the Calendar
Objectives:
By the end of this section you will be able to:
•

View and navigate calendar

•

Enter appointments and events

•

Recur appointments

•

Schedule a meeting

•

Set up and use group calendars

•

Set up reminders

•

Print the calendar

•

Customise the calendar
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Using the Calendar

The Calendar folder allows the user to keep track of their schedule and plan meetings with others. If the user has the
appropriate access rights, they can open other users’ Calendar folder and schedule activities or edit existing activities.

)To Open the Calendar:
Mouse

J



•

In the Navigation Pane, click

•

By default, the Calendar folder automatically opens showing today’s date and displays one day at a time.



Alternatively, the Calendar folder settings can be altered to display a week or a month at a time.

)To Display a Day, Work Week, Week and a Month at a Time:
Menu

•

Choose View, Day or Work Week or Week or Month.

•

Click

Mouse

)To Display Today’s Date:
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Mouse
•

6.2

Click

.

Moving Between Dates

The Date Navigator is used to quickly select one or more days in the Calendar. Days that display in bold in the Date
Navigator indicate days that contain items, e.g. appointments. The current date displays in a border. If an activity has been
scheduled on a specific day by mistake, the Date Navigator allows the user to quickly move the activity to another day.

)To Display a Specific Day:
Mouse

•

In the Date Navigator, click the day required. The Calendar now displays the selected day.

To display multiple adjacent days, in the Date Navigator click and drag the days required. To display non-adjacent days,
press [CTRL] and click on the days required.

)To Display a Specific Month:
Mouse

•

In the Date Navigator, click on the name of month currently displayed, e.g. April. A list of month’s displays.

•

Select the month required

•

Release the mouse. The Calendar displays the selected month.

Or

&OLFN
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)To Go To a Specific Date:
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Menu
•

Choose Tools, Go to Date

•

In the Date box, select the date required

•

To display the date as a single day or within a week or month, in the Show in box, select the option required

•

Choose OK

Keyboard

6.3

•

Press [CTRL] [G]

•

Follow steps 2 to 4 as menu method

Scheduling Appointments

Appointments are activities that you schedule in your calendar that do not involve inviting other people or reserving
resources. You can set reminders for your appointments. You can also specify how your calendar looks to others by
designating the time an appointment takes as busy, free, tentative, or out of office. You can schedule recurring appointments.
You can view your appointments by day, week, or month.
You can schedule an appointment in your own calendar, and others can give you permission to schedule or make changes
to appointments in their calendars. Appointments can also be made private.
When viewing days, blocks of time that have been scheduled appear with a colour or pattern to indicate how the time is
used. The colour or pattern identifies time as free, busy, tentatively busy or out of office.
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Time

Colour

Free

Clear or no colour

Busy

Blue

Out of office

Purple

Tentative

Diagonal stripe blue

)To Schedule an Appointment:
Menu

•

Choose File, New, Appointment or in the Calendar folder, choose Actions, New Appointment

•

In the Calendar folder, click the right mouse button on a date in the Calendar, choose New Appointment or

Or
click
•

.

Click Cancel Invitation from the appointment toolbar.



•

In the Subject box, type a description, e.g. Hospital appointment.

•

In the Location box, type a location, e.g. Manchester Royal Infirmary.

•

In the Start time box, select the start date and time.

•

in the End time box, select the finish date and time.

•

In the Show time as box, select the time status required, e.g. Busy.
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The status of an appointment affects how it displays to others when they view the Calendar. By default, appointments
display as busy and are blanked out to other users.
•

If required, in the Text box, type the appointment details.

•

To hide the item so others who have access to this folder cannot see it, choose Private.

•

To save the appointment, click

. The appointment now displays in Calendar.

If an appointment has been set as private, a symbol

will display next to it in the Calendar.

To Select an Appointment:
Mouse
•

Display the required date and click on the appointment.

6L]HKDQGOH
0RYHKDQGOH

•

A move handle displays to the left of the selected appointment and sizing handles display at the top and
bottom.

)To Edit an Appointment:
Menu

•

Select the appointment to edit.

•

Choose File, Open.

•

Click the right mouse button on the appointment to edit, choose Open.

•

The appointment form displays.

•

Edit the appointment as required, e.g. change the start and end times.

•

Click

•

Double-click the left move handle of the appointment to edit

•

Edit the appointment as required, e.g. change the start and end times

•

Click

Or

.

Mouse

.

)To Move an Appointment:
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Menu
•

Click the left move handle of the appointment to move.

•

When the mouse pointer is positioned on the move handle it changes to a shape

•

Choose Edit, Cut.

•

Select the new date and time for the appointment.

•

Choose Edit, Paste.

•

To change the time an appointment is schedule for, click and drag the appointments move handle to the

.

Mouse
time required.
Or
•

To change the date an appointment is scheduled, click and drag the appointments move handle to the date
required in the Date Navigator Release the mouse.

)To Copy an Appointment:
Menu

•

Click the left move handle of the appointment to copy.

•

When the mouse pointer is positioned on the move handle it changes to a shape .

•

Choose Edit, Copy.
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•

Select the new date and time for the appointment.

•

Choose Edit, Paste.

•

Press [CTRL] + click and drag the appointment’s move handle to the time required.

•

Press [CTRL] + click and drag the appointments move handle to the date required in the Date Navigator.

•

Release the mouse.

Mouse

Or

)To Delete an Appointment:
Menu

•

Select the appointment no longer required.

•

Choose Edit, Delete.

•

Select the appointment no longer required.

•

Click

Mouse
.

Setting an Appointment Reminder
When the user schedules an appointment in the Calendar, they can also set a reminder. The reminder dialog box will
display at an interval set by the user prior to the appointment. E.g. 15 minutes prior to the appointment.

)To Set an Appointment Reminder:
Mouse

•

Open the appointment to set a reminder for.

•

Create a new appointment.

•

Choose Reminder. Ensure the check box is ticked.

•

Type the amount of time before the appointment when the reminder is to display, e.g. 10 minutes.

•

To customise the reminder action for this appointment, click

•

On completion, click

Or

select the sound to play and choose OK.

.

If a reminder has been set on an appointment, a A symbol displays next to it in the Calendar.
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When the time set for the reminder is reached, the Reminder dialog box will display and the selected sound will play.

6.4

Recurring Appointments

If the user wants an appointment to repeat, instead of copying the appointment repeatedly, they can designate it as a
recurring appointment.
A C symbol displays in the Calendar next to recurring appointments.

)To Create a Recurring Appointment:
Menu

•

Open the appointment to make recurring and choose Actions, Recurrence.

•

Create a new appointment and choose Appointment, Recurrence.

•

The Appointment Recurrence dialog box displays.

Or
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•

Choose the options required.

•

Choose OK.

www.sylvania.com
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Fascinating lighting offers an infinite spectrum of
possibilities: Innovative technologies and new
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demand. Enjoy the supportive working atmosphere
within our global group and benefit from international
career paths. Implement sustainable ideas in close
cooperation with other specialists and contribute to
influencing our future. Come and join us in reinventing
light every day.
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If the appointment is a new appointment, create the appointment as required, i.e. add subject and location,
start and end times.

•

Click

•

Open the appointment to make recurring.

.

Mouse
Or
•

Create a new appointment.

•

Click s

•

Follow steps 2 to 6 as menu method.

.

To Edit All Occurrences of a Recurring Appointment:
Menu
•

Open any occurrence of the recurring appointment.



•

The Open Recurring Item dialog box displays.

•

Choose Open the series.

•

Choose OK.

•

Edit the appointment as required, e.g. change the subject, location, start or end times.

•

To change the appointment time, recurrence pattern or range of recurrence, choose Appointment,
Recurrence, select the options required and choose OK.

•

Click

.

)To Edit Only One Occurrence of a Recurring Appointment:
Menu

•

Open the recurring appointment to change

•

The Open Recurring Item dialog box displays.

•

Choose Open this occurrence.

•

Choose OK.
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•

Edit the appointment as required e.g. change the location.

•

Click

.

)To Delete All Occurrences of a Recurring Appointment
Mouse

•

Select any occurrence of the recurring appointment to delete.

•

Click

•

Choose Delete all occurrences.

•

Choose OK.

or press [DELETE]. The Confirm Delete dialog box displays.

)To Delete One Occurrence of a Recurring Appointment:
Mouse

•

Select any occurrence of the recurring appointment to delete.

•

Click

•

The Confirm Delete dialog box displays.

•

Choose Delete this one.

•

Choose OK

or press [DELETE]. The Confirm Delete dialog box displays.

If the user moves a recurring appointment, only the selected occurrence of the appointment is moved. If the user wishes to
move all occurrences of the appointment, they should open the appointment series and edit the recurrence pattern.

Mail Messages
Appointments can be added to the Calendar using mail messages, e.g. a mail message relating to a sales meeting can be
used to create an appointment scheduled with the user’s Sales Manager.

)To Create an Appointment Using a Mail Message:
Mouse

•

In the lnbox folder, click and drag the relevant mail message onto calendar icon

.
•

Release the mouse. Calendar opens a new appointment form. The mail message displays in the Text box.
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CHALLENGING PERSPECTIVES

Internship opportunities
EADS unites a leading aircraft manufacturer, the world’s largest
helicopter supplier, a global leader in space programmes and a
worldwide leader in global security solutions and systems to form
Europe’s largest defence and aerospace group. More than
140,000 people work at Airbus, Astrium, Cassidian and Eurocopter,
in 90 locations globally, to deliver some of the industry’s most
exciting projects.
An EADS internship offers the chance to use your theoretical
knowledge and apply it first-hand to real situations and assignments
during your studies. Given a high level of responsibility, plenty of

learning and development opportunities, and all the support you need,
you will tackle interesting challenges on state-of-the-art products.
We welcome more than 5,000 interns every year across
disciplines ranging from engineering, IT, procurement and
finance, to strategy, customer support, marketing and sales.
Positions are available in France, Germany, Spain and the UK.
To find out more and apply, visit www.jobs.eads.com. You can also
find out more on our EADS Careers Facebook page.
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Add the options required i.e. subject, location, start and end times.
Click
.

Booking Meetings

A meeting is an appointment to which other people and resources are invited. A resource could be a room, computer,
overhead projector, flip chart or any equipment that is needed at the meeting. Resources can be invited to a meeting in
the same way as people.
The Attendee Availability is used to create and send meeting requests and to reserve resources. When a meeting is created,
the user identifies the people and resources they want to invite and they choose a meeting time. If required, a meeting
can be scheduled to recur daily, weekly, monthly or yearly in the same way as any other appointment. Once a time has
been determined for the meeting, invitations can then be sent in a meeting request. An invitee can accept or decline the
invitation. If the invitee accepts, Outlook adds the meeting to the invitees’ calendar.

)To Plan a Meeting:
Menu

•

In the Calendar folder, choose Actions, Plan a meeting.

•

Use the Plan a Meeting icon on Calendar Toolbar.

Or
Mouse
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•

Use the Scroll bars to display the date and time required for the meeting.

•

Click on the grid to display the meeting selection bars.

•

Click and drag the Meeting Start Time selection bar to the time the meeting is to begin.

•

In the Meeting start time box, type the start date and time required.

•

Whilst dragging the selection bars, the mouse changes shape to a double ended arrow.

•

Click and drag the Meeting End Time selection bar to the time the meeting is to finish.

•

In the Meeting end time box, type the date and time the meeting is to end.

•

To show more than one day in the grid, choose Options, Show Zoomed Out.

•

To change the display of the hours in the grid to show only working hours, choose Options, Show Only

Or

Or

Working Hours.
•

To invite other people and resources to the meeting, either type the names in the All Attendees grid or click
Add others and choose Add from address book. The Select Attendees and Resources dialog box displays.



•

In the Type Name or Select from List box, select the name of the person or resource required at the
meeting.

•

Choose Required or Optional or Resources.
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•

Repeat steps 9 and 10 for each person and resource required and choose OK.

•

Use the Scroll bars to view the free/busy time for invitees.
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.
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thinking

.
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•

Choose Make Meeting.

•

Add the options required, e.g. subject, location, start and end times.

•

On completion, click

•

Click

•

Click on the Scheduling tab in the new appointment form Follow steps 2 to 16 as menu method.

.

Mouse

The meeting request is sent to the invitees in the form of a mail message. lnvitees open the meeting request mail message in
the same way as any other mail message. Meeting request mail displays in the lnbox with a  Vsymbol attached to it. Once
the meeting request message is opened, the invitee has the choice of accepting or declining the meeting.

)To Respond to a Meeting Request:
Menu

•

In the lnbox folder, open the meeting request mail message.

•

To see the meeting in the Calendar before responding to it, choose View, Calendar, on completion close the
Calendar.

•

To accept the meeting and place it in the Calendar, choose Appointment, Accept.

Or

J

K

L

O G

O L

O

S

J

K

O G



•

To tentatively accept the meeting and place it in the Calendar, choose Appointment, Tentative.

•

To decline a meeting, choose Decline. A dialog box displays prompting the user for the next step.

Or

Or
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To propose an alternative meeting time, click Propose New Time. Select the time you would like to propose
and click Propose Time in the propose new time window.

•

To send a response to the meeting organiser that includes comments, choose Edit the response before
sending, choose OK, type the comments required and choose the Send button.

Or
•

To send a response to the meeting organiser that does not include comments, choose Send the response
now, choose OK and choose the Send button.

Or
•

Choose Don’t send response.

•

In the lnbox folder, open the meeting request mail message.

•

To see the meeting in the Calendar before responding to it, click Calendar. On completion close the

Mouse

Calendar.
•

To accept the meeting and place it in the Calendar, click

•

To tentatively accept the meeting and place it in the Calendar, click

•

To decline the meeting, click

•

To propose an alternative meeting time, click

.

Or
.

Or
.

Or
.

Follow step 4 as menu method.
•

The meeting organiser receives meeting responses and comments in the form of mail messages. In the
1nbox, meeting response messages have symbols attached indicating the response chosen.
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Meeting response messages are opened and replied to in the same way as any other mail message.
0nce a meeting has been accepted, it is scheduled in the Calendar and has a symbol attached to it.

)To Edit a Scheduled Meeting:
Mouse

•

In the Calendar folder, open the meeting to edit.

•

The meeting details display.

•

Edit the details as required.

•

To display a time grid showing free and busy times on the invitees schedules, choose the Attendee
Availability tab and choose Show attendee availability.

•

To display the status and responses of people invited to the meeting, choose the Attendee Availability tab
and choose Show attendee status.

•

To inform invitees of the alterations made, click Send Update.

We will turn your CV into
an opportunity of a lifetime

Do you like cars? Would you like to be a part of a successful brand?
We will appreciate and reward both your enthusiasm and talent.
Send us your CV. You will be surprised where it can take you.

Send us your CV on
www.employerforlife.com
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Or
•

To alter the detail in the Calendar but not inform invitees, click

.

)To Cancel a Meeting:
Menu

•

Open the meeting to cancel.

•

Choose Appointment, Cancel Meeting. A dialog box displays prompting the user for the next step.

•

To send a response with comments to invitees, choose Send cancellation and delete meeting, choose OK,
type comments required and choose the Send button.

Or
•

To delete the meeting without informing invitees, choose Delete without sending a cancellation and choose
OK.

Mouse
•

In the Calendar folder, select the meeting to cancel.

•

Click

•

Follow step 3 as menu method.

6.6

.

Group Schedules

The Calendar group schedule makes it easy for you to see the combined schedules of a number of people or resources
at a glance.
You can create and save multiple group schedules, each showing a group of people or resources. For example, one group
schedule might contain all employees in a department. Another group schedule might contain all conference rooms in a
building. A group schedule can include all of the contacts or resources from a public folder.
In addition to inviting people to attend meetings, you can also schedule resources, such as the conference room where you
plan to hold the meeting, or the slide projector you plan to use for a presentation. In order for you to be able to schedule
a resource, it must first have been set up by an individual in the organization to have its own mailbox on your server, and
you must have been given permission to schedule resources that includes this resource.
While viewing a group schedule, you can quickly schedule a meeting with or send e-mail to some or all of the group
members. You can get the latest free/busy information for each group member before you schedule a meeting, and you
can use AutoPick to find a time that’s free for all group members.
The group calendar will by default contain details of all items shown, unless the owner of an item has marked it as private.

)To create a group schedule:
Mouse

•

Click
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Or
•

Choose Actions, View Group Schedules



•

Click New.

•

Type a name for the new group schedule, and then click OK.

•

Click Add Others, and then click either Add from Address Book or Add Public Folder.

•

Select the names or the public folder, and then click OK.

)To view a group schedule:
Mouse

•

Click Calendar and click

.

•

Select the group schedule you want to view, and then click Open.

)To delete a group schedule:
•

Select the group schedule you want to delete, and then click Delete.
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)To send a meeting request or e-mail message from a group schedule
Mouse

•

Click Calendar and click

.

•

Select the group schedule you want, and then click Open.
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Click Make Meeting, and then click either New Meeting New Meeting with All or New Mail Message or
New Mail Message with All.

Setting Up Events

An event is an activity that lasts 24 hours or longer. Examples of an event include a trade show, the Olympics, a vacation,
or a seminar. Usually, an event occurs once and can last for one day or several days, but an annual event, such as a birthday
or anniversary, occurs yearly on a specific date.
Events and annual events do not occupy blocks of time in your calendar; instead, they appear in banners. An all-day
appointment displays time as busy when viewed by others, while an event or annual event displays time as free.

)To Create an Event:
Menu

•

In the Calendar folder, choose Actions, New All Day Event.

•

Add the options required, e.g. subject, location, change the status from free to out of office.

•

Click

•

In Day/Week/Month view, double-click the banner of the day the event is to take place

•

Follow steps 2 and 3 as menu method.

.

Mouse

)To Edit an Event:
Mouse

•

Double-click on the event banner.

•

Edit the event as required, e.g. change the subject.

•

Click

.

An event can be changed into an appointment, causing the time to be blocked out in the Calendar
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)To Change an Event into an Appointment:
Mouse

•

Double-click on the event to change.

•

Choose All day event.

•

Ensure the check box is not ticked. Events are defined as lasting from midnight to midnight; clearing this
check box allows specific times to be added.

•

Add the start and end times required.

•

Click

.

)To Create an Annual Event:
Menu

•

Create an new event adding the options required, e.g. subject and location.

•

Choose Appointment, Recurrence.

•

If the event lasts longer than one day, in the Duration box, change the value.

•

Choose Yearly.

•

Select the date or day of the year required.

•

Choose OK and click

•

Create a new event adding the options required, e.g. subject and location.

•

Click C.

•

Follow steps 3 to 7 as menu method.

.

Mouse

6.7

Using the TaskPad

The TaskPad is a view of the user’s Task list held in the Tasks folder. The TaskPad can be used to view tasks in a number
of different ways, e.g. display only the tasks that are due to start today. The user can schedule time to work on a task by
dragging the task from the TaskPad to a block of time in the Calendar.

)To view the TaskPad
Mouse

•

Choose View, TaskPad from the menu
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)To Schedule Time to Work on a Task:
Mouse

•

Click and drag the task from the TaskPad to the date and time required in the Calendar.

•

Release the mouse. The Appointment dialog box displays and automatically includes the task.


7DVN'HWDLOV



•

Add the start and end times required.

•

Choose options required, e.g. set reminder.

•

Click

•

The task is now scheduled in the Calendar.

.

Any changes made to the task in the TaskPad reflect automatically in the Task list in the Tasks folder.

6.8

Using Categories

All items in Outlook can be assigned to categories. A category is a key word or phrase that the user can assign to an
item to assist them in keeping track of it. If items are categorised, they can be found or grouped easily, e.g. categorise
all personal items that the user records in Outlook in the Personal category. An item can be assigned to more than one
category. The Master Category list can be used to assign items to categories.

)To Categorise an Appointment:
Menu

•

Open the appointment to categorise.

•

Create a new appointment.

•

Choose Categories, bottom right.

Or
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•

In the Available categories box, select the category to add the appointment to, e.g. Personal.

•

Choose OK.

•

Click

•

Open the appointment to categorise, e.g. Hospital appointment.

•

Create a new appointment.

•

Click Categories.

•

Follow steps 3 to 5 as menu method.

.

Mouse

Or

Creating Categories
When assigning an item to a category, if the category required is not on the Master Category list the user can create new
categories and add them to the list.

)To Create Categories:
Menu

•

Open the appointment to categorise, e.g. Outlook 2003 training.

•

Create a new appointment.

•

Choose Edit, Category.

•

In the ltems belong to these categories box, type the new category name, e.g. Outlook Project.

•

Choose Add to List. The new category is added to the list of available categories.

•

Choose OK

Or
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Mouse
•

Open or create a new appointment.

•

Click Categories.

•

Follow steps 3 to 5 as menu method.
The Categories feature is also available when using other outlook folders, e.g. Contacts.

6.9

Calendar Colouring

Microsoft Outlook has 10 colors that you can use to color appointments and meetings. These colors are visible in Day/
Week/Month view of Calendar. You can color individual or recurring appointments and meetings manually, or you can
use rules to automatically color items that meet certain conditions, such as when a certain word is used in the subject or
when a meeting request is sent by a certain person. Manual coloring always take precedence over automatic coloring, so
if you have applied manual coloring to an item, automatic coloring will not be applied to it.
If you open another person’s calendar or a calendar stored in a public folder, you will see the colors that were assigned
manually, but no automatic coloring. Automatic coloring can be seen only by the person who set it up.
Each color comes with a label. You can change these labels to make them more meaningful to you. For example, you can
change the label of the color red from “important” to “urgent.”

)To color an appointment or meeting:
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Mouse
•

Click Calendar.

•

Right-click an appointment or meeting, point to Label on the shortcut menu, and then click a color in the
list or start a new appointment and click label drop-down list in the new appointment window.

•

To remove a color from the appointment or meeting, in the Label list, click None.

)Color a recurring appointment or meeting:
Mouse

6.10

•

Click Calendar.

•

Open an appointment or meeting.

•

Click Open the series, and then click OK.

•

In the Label list, click a color.

•

To remove a color from the appointment or meeting, in the Label list, click None.

Viewing the Calendar

Outlook 2003 allows the Calendar folder display to be altered using one of the following Views:
View

Description

Day/Week/Months

Displays appointments, events and meetings for one or more days or weeks or
months. This view also includes a list of tasks.

Active Appointments

Displays a list of all appointments and meetings that start today and go into
the future and includes their details.

Events

Displays a list of all events and includes their details.

Annual Events

Displays a list of events that happen once a year and includes their details.

Recurring Appointments

Displays a list of recurring appointments and includes their details.

By Category

Displays a list of all Calendar items grouped by category and includes their
details.

)To Change the Calendar View:
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Menu
•

In the Calendar folder, choose View, Arrange By, Current View

•

Choose the view required, e.g. By Category

•

Click the arrow to the right of

•

Select the view required, e.g. By Category

Mouse
.

TaskPad Views
Tasks can also be viewed in different ways by changing the view of the TaskPad in the Day/Week/Month view of the Calendar.
Views

Description

All Tasks

Displays all tasks in the list.

Today’s Tasks

Displays tasks that are due on or after the current day.

Active Tasks for Selected Days

Displays tasks that are due or completed on the selected days. If several
non-adjacent days are selected when days are viewed, only the tasks due or
completed on the first selected day will display.

Tasks for Next Seven Days

Displays tasks that have not been marked complete.

Overdue Tasks

Displays incomplete tasks with due dates that have expired.

Tasks Completed on Selected Days

Displays tasks that have been marked complete on the selected days.

Include Tasks With No Due Date

Includes tasks that have no due date when the user selects another TaskPad
view.

)To Change the TaskPad View:
Menu

•

Ensure the Calendar is displaying in the Day/Week/Month view.

•

Choose View, TaskPad View.

•

Choose the view required.

6.11

Printing the Calendar

The user can print Calendar items, e.g. today’s appointments and meetings, or the view of everything seen on screen can
be printed.

)To Print a Calendar Item:
Menu

•

In the Calendar, select the items to print.

•

Choose File, Print.
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•

In the Print Style section, choose Memo Style.

•

Choose print options required.

•

Choose OK.
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)To Print a View:
Menu

•

In the Calendar folder, choose File, Print.

•

In the Print Style section, choose Daily Style.

Or
Choose Weekly Style.
Or
Choose Monthly Style.
Or
Choose Tri-fold style. (The Tri-fold style can be printed for use as a paper day planner).
•

To print a set number of days, in the Start box, choose the first day to print.

•

in the End box, choose the last day to print.

If the user tries to print a range of days that is less than the range of days in the selected print style, the range of days
in the print style will print, e.g. if four days is selected to print in the Weekly print style, the week surrounding the four
days prints.
•

Choose print options required.

•

Choose OK.

6.12

Customising the Appearance of Calendar

The user can customise the way that the Calendar looks, e.g. appointment times can be set to display as miniature clocks,
national and international holidays can quickly be added to the Calendar.

)To Display Appointment Times as Miniature Clocks in Week or Month View:
Menu

•

In the Calendar folder, choose View, Arrange By, Current View, Customize Current View then choose Other
Settings.

•

In the Week section, choose Show times as clocks.

Or
In the Month section, choose Show times as clocks.
•

Choose OK.
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)To Turn Off Bold Appointments in the Date Navigator:
Menu

•

In the Calendar folder, choose View, Arrange By, Current View, Customize Current View, Other Settings, on
General Settings Choose Bolded dates in Date Navigator represent days containing items.

•

Ensure the check box is not ticked.

•

Choose OK.

)To Show Week Numbers in the Date Navigator:
Menu

•

In the Calendar folder, choose Tools, Options.

•

Choose Calendar Options, Show week numbers in the Date Navigator.

•

Ensure the check box is ticked.

•

Choose OK.

The weeks of the year are assigned a number from 1 to 52, called week numbers. These numbers appear on the left side
of the Date Navigator.

)To Display Saturday and Sunday Together in a Monthly Calendar:
Menu

•

In the Calendar folder, choose View, Arrange By, Current View, Customize Current View, Other Settings.

•

Choose Compress weekend days.

•

Ensure the check box is ticked and choose OK.
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)To Add World Holidays to the Calendar:
Menu

•

In the Calendar folder, choose Tools, Options.

•

Choose the Calendar Options.

•

Choose Add Holidays.

•

Select the countries with the holidays to add to the Calendar.


•

Choose OK. The holidays for the chosen country are now imported into the Calendar.

•

Choose OK.

.
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7 The Task List
Objectives:
By the end of this section you will be able to:
•

Enter tasks

•

Repeat tasks

•

Assign tasks to others

•

Track tasks
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The Task List

The Tasks List

A task is an assigned piece of work that must be completed within a certain time, e.g. writing a proposal or reading a report.

)To Open Tasks:
Mouse

•

7.2


.

In the Outlook bar, click

Working with Tasks

A task can occur once or be repeated as a recurring task. A recurring task can repeat at regular intervals or based on the
dates the user marks the task to be completed.

)To Create a Task:
Menu

•

Choose File, New, Task.

•

Click the New button. The New Task form displays.

Or



Options

Description

Subject

Description of the task.

Due date

Indicates whether or not a task starts and ends at a specific time. The
AutoDate feature can be used when entering the due date.

Status

Indicates the status of the task, e.g. in progress. The status is displayed when
sending a status report.
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Sets the importance level of the task as high, normal, or low. By default, tasks
are assigned normal priority.

% Complete

The percentage of the task that is finished.

Reminder

Displays a reminder for the item.

Owner

The person who created the task. If the task is sent to another person, that
person becomes the owner of the task.

Categories

Displays words to find or group related items.

Private

Hides the item so others who have access to this folder can not see it.

•

In the Subject box, type a task description.

•

Choose options required, e.g. due date.

•

Click

•

In the Task list, click Click here to add a task

•

Type a task description.

•

Press [ENTER].

. The task displays in the Task list.

Mouse

)To Create a Recurring Task:
Menu

•

Choose File, New, Task.

> Apply now
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Or
•

In the Tasks folder, choose Tasks, New Task.

•

The New Task form displays.

•

In the Subject box, type a task description.

•

Choose options required, e.g. due date.

•

Click

•

Set the recurring options required.

•

Choose OK.

.

A note is displayed in the lnfobar indicating the specifics of the recurring task and when the first occurrence of the task
is due.

•

Click

.

The recurring task displays in the Task list with a recurring task symbol attached to it.

7.3

Editing Tasks

A task can be edited directly in the Task list or using the Task form.

)To Edit a Task in the Task Form:
Mouse

•

In the Task list, double-click on the task to edit The Task form displays.

•

Edit the task as required. e.g. change the due date.

•

Click

.

)To Edit a Task in the Task List:
Mouse

•

In the Task list, click in the column to edit.

Clicking in the Subject column of a specific task will display the insertion point and allow the user to add and
delete text. Clicking in many of the other columns of a specific task will display a drop-down arrow. The dropdown arrow can be used to display options for changing the task information.
•

7.4

Edit the task as required.

Deleting a Task

If the user decides that a task should no longer remain in the Task list, they can delete it.

)To Delete a Task:
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Menu
•

In the Task list, select the task no longer required.

•

Choose Edit, Delete.

•

Click the right mouse button on the selected task, choose Delete.

•

In the Task list, select the task no longer required.

•

Click

Or
Mouse

7.5

.

Viewing Tasks

The default view for the Tasks folder is Simple List. This view displays very few details about a task. Outlook 2003 allows
the Tasks folder display to be altered using one of the following views:
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View
Simple List
Detailed List
Active Tasks

The Task List

Description
Displays a list with only a few details allowing the user to see at a glance the
tasks that are complete.
Displays a list that shows many details about each task. Including priority and
percentage complete.
Displays a list that shows only incomplete tasks, including ones that are
overdue.

Next Seven Days

Displays a list that shows only the tasks that are due in the next seven days.

Overdue Tasks

Displays a list that shows only the tasks that are overdue.

By Category
Assignment
By Person Responsible
Completed Tasks
Task Timeline

Displays a list, grouped by category and sorted by due date within each
category.
Displays a list that shows only the tasks that have been assigned to others,
sorted by task owner and due date.
Displays a list, grouped by task owner and sorted by due date for each task
owner.
Displays a list that shows only the tasks that have been marked complete.
Represented by icons on a timeline, arranged in chronological order by start
date. Tasks without start dates are arranged by due date.

)To Change View:
Menu

•

In the Tasks folder, choose View, Arrange By, Current View.

•

Choose the view required.

•

In the Tasks folder, click the arrow to the right of

•

Select the view required. Each view displays the task symbol, subject and due date.

Mouse

7.6

.

Marking Tasks as Complete

Once a task has been completed, the task can then be marked as complete. When a task is marked as complete, it remains
in the Task list. A tick displays in the Completed column of the Task list and a line is displayed through the task.
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)To Mark a Task as Complete:
Menu

•

In the Task list, double-click the task to mark complete.

•

In the Status box, choose Completed.

•

Click
through the task.

•

In the Task list, click in the Completed column of the required task.

•

A tick displays in the Completed column of the Task list and a line is displayed through the task.

. A tick displays in the Completed column of the Task list and a line is displayed

Mouse

7.7

Assigning Tasks

Tasks can be assigned to other users. Before the user can assign a task to another user, they must send a task request.
Once a task request is sent, the user is no longer the task’s owner. However, the user can keep an updated copy of the task
in their Task list and request a status report on the task when it is complete.

)To Create a Task Request:
Menu

•

Choose File. New, Task.

•

In the Tasks folder, choose Actions, New Task Request The Task form displays.

Or
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•

Click

. The Select Task Recipient dialog box displays.

•

Select the recipient required and click.

•

Choose OK.
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•

In the Subject box, type a task description.

•

Choose the options required, e.g. due date.

•

To keep an updated copy of the task in the Task list, ensure the Keep an updated copy of this task on my
task list box is ticked.

•

To receive a status report when this task is complete, ensure that the Send me a status report when this task
is complete box is ticked.

•
•

Click
In the Task list, a
left of the task.

.
symbol indicating that the task has been assigned to another person displays to the

Tracking Assigned Tasks
When the task request is received, the receiver becomes the temporary owner of the task. The receiver can accept the
task, decline the task, or assign the task to someone else. If the receiver accepts the task, they become the new permanent
owner and the only person that can make changes to the task. If the receiver declines the task, they have the opportunity
to give a reason why, and the task is returned to the person who sent the task request.
A Task Request displays in the Inbox as a mail message with a symbol attached to it.

)To Accept a Task Request:
Mouse

•

In the lnbox folder, open the message that contains the task request. The Task form displays.

•

Click Accept. The Accepting Tasks dialog box displays.
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•

To accept without comment, choose Send the response now and choose OK.

•

To accept and return a comment, choose Edit the response before sending, choose OK, type the comment

Or
required and choose the Send button.
The mail message is removed from the receiver’s lnbox and added to their Task list in the Tasks folder. In the receiver’s
Tasks folder, a symbol displays to the left of the task, indicating that the task has been assigned to them by another person.
The task requester receives a mail message in their inbox with an “accepted” symbol and a note attached indicating that
the assigned task was accepted. This message can be opened in the same way as any other mail message. Once the message
has been opened it is automatically removed from the requester’s lnbox.

)To Decline a Task Request:
Mouse

•

In the lnbox folder, open the message that contains the task request. The Task form displays.

•

Click Decline. The Declining Task dialog box displays.

•

To decline without comment, choose Send the response now and choose OK.

•

To decline and return a comment, choose Edit the response before sending, choose OK, type the comment

Or
required, choose the Send button.
The mail message is automatically removed from the receiver’s lnbox. The task requester receives a mail message in their
Inbox with a “Declined” symbol, and a note attached indicating that the assigned task was declined. This message can
be opened in the same way as any other mail message. Once the message has been opened it is automatically removed
from the requester’s lnbox.
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)To Assign a Task Request to Someone Else:
Mouse

•

In the lnbox folder, open the message that contains the task request. The Task form displays.

•

Click

•

In the To box, add the name of the person to assign the task to.

•

To keep an updated copy of the task in the Task list, ensure the Keep an updated copy of this task on my

.

task list box is ticked.
•

To receive a status report when this task is complete, ensure that the Send me a status report when this task
is complete box is ticked.

•

Click

.
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8 Notes
Objectives:
By the end of this section you will be able to:
•

Create, edit and delete Notes

•

Change the view of Notes

•

Send notes to others

•

Save notes on your desktop
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8.1

Notes

Notes

Notes are the electronic equivalent of paper sticky notes. Use notes to write down questions, ideas, reminders, and anything
you would write on note paper. You can leave notes open on the screen while you work. This is especially convenient
when you’re using notes for storing bits of information you may need later, such as directions or text you want to reuse
in other items or documents.

)To Open Notes:
Mouse

•



In the Outlook bar, click

Notes display in the Notes list. By default, the Notes folder automatically opens in Icons view.

8.2

Creating, Editing and Deleting Notes

When the user creates a new note, a window displays in which the note is typed. By default, the date and time the note
was created displays at the bottom of the Note window. The note can be moved and resized on screen, and the colour can
be altered if required. Once the user has created a note, it can be left open on screen while the user works.

)To Create a New Note:
Menu

•

Choose File, New Note.
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Or
•

In the Notes folder, choose Note, New Note. The Notes window displays.

•

Type the text required.

•

To close the note, click

. The note is automatically saved and displayed in the Notes list. Notes are

arranged in the Notes list from left to right by creation date.
Mouse
•

In the Notes folder, click

•

Follow steps 2 and 3 as menu method.

.

If required the user can leave a note open and work in another folder, e.g. the Contacts folder. When the user opens another
folder, the note is removed from screen. To quickly redisplay the note, click on it in the Taskbar.

)To Edit a Note:
Menu

•

In the Notes list, select the note to edit.

•

Choose File, Open.

•

Click the right mouse button on the selected note, choose Open.

•

Edit the text as required.

•

To close the note, click

•

In the Notes list, double-click on the note to edit.

•

The Note window opens.

•

Follow steps 4 and 5 as menu method.

Or

.

Mouse
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)To Move a Note:
Mouse

•

Open the note to move.

•

Position the mouse on the Note bar at the top of the Note window. The mouse changes to an arrow head.

•

Click and drag the note to the new location.

•

Release the mouse.

)To move a note to your desktop
Mouse

•

Open the note to move.

•

Minimise other windows.

•

Click and drag the note to the new location on your desktop.

•

Release the mouse.

)To Resize a Note:
Mouse

•

Open the note to resize.

•

Position the mouse on the bottom right corner of the Note window. The mouse changes to a double-headed
arrow.

•

Click and drag inwards to decrease the note size.

•

Click and drag outwards to increase the note size.

•

Release the mouse.

)To Change a Note’s Colour:
Menu

•

Open the note required.

•

Click the Note icon at the top of the Note window.

•

A drop-down menu displays.

•

Choose Color.

•

Choose the colour required.

)To Delete a Note:
Menu

•

In the Notes list, select the note no longer required.

•

Choose Edit, Delete.

•

Click the right mouse button on the selected note, choose Delete.

Or

Mouse
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•

In the Notes list, select the note no longer required.

•

Click

.

)To forward a note:

Mouse
•

Open the note to forward to others.

•

Click on the note

•

Click Forward, a new message window appears.

icon.
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•

8.3

Complete the required fields and send.

Changing the View of notes

Outlook 2003 allows the Notes folder display to be altered using one of the following views:
View

Description

Icons

Displays notes represented by icons arranged from left to
right by creation date.

Notes list

Displays notes in a list sorted by creation date.

Last Seven Days

Displays notes created during the last seven days, in a
list.

By Category

Displays notes in a list grouped by categories and sorted
by creation date within each category.

By Color

Displays notes in a list grouped by colour and sorted by
creation date for each colour.
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)To Change Notes View:
Menu

•

In the Notes folder, choose View, Arrange By, Current View.

•

Choose the view required.

•

Click the arrow to the right of

•

Select the view required.

Mouse

8.4

.

Changing Notes Defaults

The user can quickly alter the way in which all new notes display, e.g. alter the colour, size and font.

)To Change Notes Defaults:
Menu

•

Choose Tools, Options. Choose the Tasks/Notes tab.
Notes defaults

Description

Color

Allows the user to alter the colour of all new notes. Yellow is the default. Changing
this option will not affect any existing notes only new ones.

Size

Allows the user to alter the size of all new notes to smart, medium or large. Medium
is the default. Changing this option will not affect any existing notes only new ones.

Font

Specifies the default font used for notes. Changing this default will affect all new and
existing notes.

Show date and time

If selected, shows the date and time at the bottom of the note, indicating when it was
created or last changed. Changing this default will affect all new and existing notes.

•

Choose the options required. Choose OK.
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9 Sharing Folders
Objectives:
By the end of this section you will be able to:
•

Delegate access

•

Open other’s calendar

•

Share your private folders

•

Add other’s mailbox to you folder list
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Sharing Folders

Just as you might have an assistant who helps you manage your incoming paper mail, Microsoft Outlook provides similar
functionality by making it possible for you to give another person access to your Inbox and any other Outlook folder you
want. The process of granting someone permission to open your folders, read and create items, and respond to requests
for you is called delegate access.
As the person granting permission, you determine the level of access the delegate has. You can give a delegate permission
to read items in your folders, or to read, create, modify, and delete items. You can give a delegate permission to send mail
and to respond to mail on your behalf. The delegate can also organize meetings on your behalf and respond to meeting
requests and task requests sent to you. If you grant someone access to your folders, that delegate has access to the personal
items in the folders.
If you want to use the Delegate Access feature, your mail must be delivered to your mailbox on the server, not to a personal
folders file on your hard disk.

9.2

Delegate Access permissions

Following are the levels of permission that a delegate can be granted:
Access

Permission

Author

Read and create items, and modify and delete items you create. For
example, a delegate can create task requests and meeting requests directly
in the manager’s Task or Calendar folder, and then send either item on the
manager’s behalf.

Editor

Do everything an Author can do, plus modify and delete the items the
manager created

Reviewer

Read items; for example a delegate with Reviewer permission can read
messages in another person’s Inbox

With author or editor permissions, the delegate has send-on-behalf-of permission. Sent messages contain both the
manager’s and delegate’s names. Message recipients see the manager’s name in the Sent On Behalf Of box and the delegate’s
name in the From box.
If a delegate needs permission to deal with meeting requests and responses only, the manager can select the Send
meeting requests and responses only to my delegates, not to me check box on the Delegates tab and does not need to
grant permission to his Inbox. Meeting requests and responses will go directly to the delegate’s Inbox. The delegate will,
however, need editor permission to the manager’s Calendar folder, because once they respond to the meeting on behalf
of the manager, the meeting is automatically added to the manager’s Calendar folder.

)To grant permissions to others:
Menu

•

On the Tools menu, click Options, and then click the Delegates tab.
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•

Click Add and select the name from relevant the address book and click OK.

•

Change the permissions for any Microsoft Outlook folder that the delegate has access to.

www.sylvania.com

We do not reinvent
the wheel we reinvent
light.
Fascinating lighting offers an infinite spectrum of
possibilities: Innovative technologies and new
markets provide both opportunities and challenges.
An environment in which your expertise is in high
demand. Enjoy the supportive working atmosphere
within our global group and benefit from international
career paths. Implement sustainable ideas in close
cooperation with other specialists and contribute to
influencing our future. Come and join us in reinventing
light every day.

Light is OSRAM
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To send a message to notify the delegate of the changed permissions, select the Automatically send a
message to delegate summarizing these permissions check box.

•

Click OK.

•

If you want your delegate to be sent copies of meeting requests and responses sent to you, give the delegate
editor permission to your Calendar folder, and then select the Delegate receives copies of meeting-related
messages sent to me check box.

•

9.3

Click OK.

Sharing Private Folders

If your administrator has set up a public folder, you may have permission to use some or all of the folders within the
public folder. If someone has shared one of their private folders with you or designated you as a delegate for that folder,
then you have permission to perform certain activities in that folder. The extent of the activities you can perform in a
public folder, shared private folder, or folder you are a delegate for, depends on your role (or combination of permissions)
in that folder, as described next. With this permission level (or role).
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Access

Permission

Owner

Create, read, modify, and delete all items and files, and create subfolders. As
the folder owner, you can change the permission levels others have for the
folder. (Does not apply to delegates.)

Publishing Editor

Create, read, modify, and delete all items and files, and create subfolders. (Does
not apply to delegates.)

Editor

Create, read, modify, and delete all items and files

Publishing Author

Create and read items and files, create subfolders, and modify and delete items
and files you create. (Does not apply to delegates.)

Author

Create and read items and files, and modify and delete items and files you
create

Contributor

Create items and files only. The contents of the folder do not appear. (Does not
apply to delegates.)

Reviewer

Read items and files only

Custom

Perform activities defined by the folder owner. (Does not apply to delegates.)

None

You have no permission. You can’t open the folder

)To share a folder using permissions:
Mouse

•

In the Navigation Pane, right-click the private or public folder you want to share, and then click Properties
on the shortcut menu.

You must have Owner permission for a public folder to set sharing permissions for the folder. You can set permissions for
only one folder at a time.
•

Click the Permissions tab.

•

Click Add.

•

In the Type name or select from list box, enter the name of the person you want to grant sharing
permissions to.

•

Click Add, and then click OK.

•

In the Name box, click the name of the person you just added.

•

Under Permissions, choose the settings you want and click OK.

For public folders, you can assign everyone who has access to the folder the same permissions by clicking Default in the Name
box.
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CHALLENGING PERSPECTIVES

Internship opportunities
EADS unites a leading aircraft manufacturer, the world’s largest
helicopter supplier, a global leader in space programmes and a
worldwide leader in global security solutions and systems to form
Europe’s largest defence and aerospace group. More than
140,000 people work at Airbus, Astrium, Cassidian and Eurocopter,
in 90 locations globally, to deliver some of the industry’s most
exciting projects.
An EADS internship offers the chance to use your theoretical
knowledge and apply it first-hand to real situations and assignments
during your studies. Given a high level of responsibility, plenty of

learning and development opportunities, and all the support you need,
you will tackle interesting challenges on state-of-the-art products.
We welcome more than 5,000 interns every year across
disciplines ranging from engineering, IT, procurement and
finance, to strategy, customer support, marketing and sales.
Positions are available in France, Germany, Spain and the UK.
To find out more and apply, visit www.jobs.eads.com. You can also
find out more on our EADS Careers Facebook page.
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Item

Description

Name/Permission Level

Displays user names and their permissions for the folder. The default permission is
the role granted to all general users.

Add

Selects user, distribution list, and public folder names to add to the Name/Role box.

Remove

Removes the selected name from the Name/Role box.

Properties

Displays details about the selected name.

Permissions

Specifies a role for the selected name. When you select a role, the permissions
associated with that role are automatically selected. When you select individual
permissions, the matching role name appears in the Roles box. If there is no
matching role, Custom appears. You cannot select Custom; it appears automatically.

Roles

Specifies a role for the selected name in the Name/Role box.

Owner

Grants all permissions in the folder. Create, read, modify, and delete all items and
files and create subfolders. The owner can also change permission levels that others
have for the folder.

Publishing Editor

Grants permission to create, read, modify and delete all items and files, and create
subfolders.

Editor

Grants permission to create, read, modify, and delete all items and files.

Publishing Author

Grants permission to create and read items and files, modify and delete items and
files you create, and create subfolders.

Author

Grants permission to create and read items and files, and modify and delete items
and files you create.

Nonediting Author

Grants permission to create and read items and files.

Reviewer

Grants permission to read items and files only.

Contributor

Grants permission to create items and files only. The contents of the folder do not
appear.

None

Grants no permission in the folder. Use this as the default permission when you
want to limit the folder audience to only users you specifically add to the Name/Role
box.

Create Items

Grants permission to post items in the folder.

Read Items

Grants permission to open any item in the folder.

Create Subfolder

Grants permission to create subfolders in the folder.

Folder Owner

Grants all permissions in the folder.

Folder Contact

Grants folder contact status. Folder contacts receive automated notifications from
the folder, such as replication conflict messages, as well as requests from users for
additional permissions or other changes in the folder.

Folder visible

Grants permission to see the folder.

Edit Items

Select None, Own or All.

None

Does not allow changes to any item.

Own

Allows you to modify items you create.

All

Allows you to modify any item.
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Delete Items

Select None, Own or All.

None

Does not allow you to delete any item.

Own

Allows you to delete items you create.

All

Allows you to delete any item.

Apply

Applies the changes you make while the dialog box is still open.

Remove sharing permissions for a folder

)To remove sharing permission:
Mouse

•

In the Navigation Pane, right-click the folder you want, and then click Properties on the shortcut menu.

•

Click the Permissions tab.

•

In the Name box, click the name of the person you want to remove sharing permission for.

•

Click Remove.

Open another person’s folder

)To open another person’s folder:
Mouse

•

On the File menu, point to Open, and then click Other User’s Folder.

•

In the Name box, type the name of the person who granted you sharing or delegate access permission, or
click Name to select from a list.

•

In the Navigation Pane, click the folder you want to open.

If you have author or editor permission, any items you create while the shared folder is active are stored in the other person’s
folder.

Add someone else’s folder(s) to the Navigation Pane

In order for you to import someone else’s folder list, they must also be using Microsoft Exchange Server. They also must
have given you permission to see their main mailbox.

)To add somebody else’s mailbox to the Navigation Pane:
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Menu
•

Click Inbox.

•

On the Tools menu, click E-mail Accounts.

•

Click View or change existing e-mail accounts, and then click Next.

•

Click Microsoft Exchange Server, and then click Change.

•

Click More Settings.

•

Click the Advanced tab, and then click Add.

•

In the Add mailbox box, type the other person’s name.

•

Click OK twice.

•

Click Next, and then click Finish.

)To create a shortcut for somebody else’s calendar:
Mouse

360°
thinking

•

Follow the step above to add the somebody else’s mailbox to the Navigation Pane.

•

In the Navigation Pane, expand the other person’s mailbox so that the Calendar folder appears.

•

Drag the Calendar folder to the Outlook Bar.

360°
thinking

.

.

360°
thinking

.
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10 Defining Views
Objectives:
By the end of this section you will be able to:
•

Understand view properties

•

Create a new view

We will turn your CV into
an opportunity of a lifetime

Do you like cars? Would you like to be a part of a successful brand?
We will appreciate and reward both your enthusiasm and talent.
Send us your CV. You will be surprised where it can take you.

Send us your CV on
www.employerforlife.com
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Define Views

If the user finds that a particular view they require is not available in Outlook they can create their own custom view, e.g.
create a view based on a specific category.

)To Create a Custom View in Calendar:
Menu

•

Choose View, Arrange By, Current View, Define Views.

•

Choose New. The Create a New View dialog box displays.

•

In the Name of view box, type the name required, e.g. Outlook Project View.

•

To determine the basic structure of the view, in the Type of view box, choose the view type required, e.g.
Table.
Type of view

Description

Table

Items display in a grid of rows and columns. Each row contains one item.
Details about items are in columns. To control the level of detail that
appears, columns can be added and removed, items can be filtered by criteria
specified by the user, or items can be sorted or grouped. A table view type is
best to view mail messages, tasks and details about any other item.

Timeline

Items appear as icons arranged in chronological order from left to right on a
time scale. A timeline view type is best to view journal entries and any items
that the user wants to plot in relation to time.

Day/Week/Month

Items are arranged on the Calendar, similar to a paper day planner. Items
can be viewed in blocks of time for one or more days or weeks or for a
month. A day/week/month view type is best to view appointments and
meetings, and tasks scheduled for work on specific dates.

Card

Items appear as individual cards similar to an address card file. To control
the level of detail that appears, fields can be added or removed in an item or
items can be filtered by criteria the user specifies. A card view type is best to
view contacts and any items the user wants to find quickly in alphabetical
order.

Icon

Items and files are represented by individual icons arranged on an invisible
grid. An icon view is best to view notes and files as large icons, small icons
or in a list of icons.
]

•

To specify the folders the view is available in and whether others can see the view, in the Can be used on
box, choose the option required, e.g. All Appointment folders Choose OK. The View Settings dialog box
displays.
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Button

Description

Fields

Used to change the fields that display in the current
view.

Group By

Used to change the groups in the current view.

Sort

Used to change the sort order in the current view.

Fitter

Used to select which items display in the current view.

Format

Used to format items in the current view.

•

Choose the options required, e.g. choose Fields and add fields required.

•

Choose OK to close the View Summary dialog box. On completion, choose Apply View.

The custom view is created and displays on screen. The user can switch between views in the normal way, e.g. choose
View, Arrange By, Current View and select the view required.

The Define View feature is also available when using other Outlook folders, e.g. Contacts, Tasks.
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11 Routing Slips
Objectives:
By the end of this section you will be able to:
•

Route a file

•

Track changes

•

Review changes
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Routing Slips

You can send an active file to reviewers to change and add comments. To use routing, you and those you are sending the
document to must have installed both the application such as Word, in which the document was created and Microsoft
Outlook or a compatible mail package.
When you route a file, it is sent as an attachment in an e-mail message. You can select a group alias as the recipient;
however, all members of the alias are considered one recipient. To route to members of a group alias one after another,
route it to individual members instead of to the alias.

11.2

To route a file

)To route a file:
Menu

•

Open the file you want to route in Word, Excel etc.

•

On the File menu, point to Send To, and then click Routing Recipient.



•

To select recipients, click Address. In the Type name or select from list box, enter a name, and then click To.
Repeat this step for each additional recipient, and then click OK.

•

To route the file, click Route.

•

To close the dialog box without routing the file, click Add Slip.

•

To route the file at a later time, open it, click Send To on the File menu, and then click Next Routing
Recipient.

•

When you route a file, it is sent as an attachment in an e-mail message with the following form:
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•

Launch the attachment and make necessary amendments

•

To send it to next recipient in the list, choose File, Send To, Next Routing Recipient.

•

To send it to other recipient in the list, choose File, Send To, Other Routing Recipient.

•

Once the document has completed its routing, the following e-mail will be sent to the originator of the
routing slip:



11.3

Review tracked changes and comments

Once the document has completed its routing, you can easily view tracked changes and comments in a document. In
order to preserve the layout of your document, Word shows some markup elements in the text of the document while
others are displayed in balloons that appear in the margin.
If comments and tracked changes such as insertions, deletions, and formatting changes are not already displayed in your
document, click Markup on the View menu.

Clicking Markup on the View menu will display or hide all markup in the document. When you display all markup, all types
of markup will be selected on the Show menu.
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)To review each item in sequence:
Menu

•

Choose View, Toolbars and Reviewing from the menu bar to display the Reviewing toolbar.

•

Click Next

•

Click Accept Change

•

Click the arrow next to Accept Change

or Previous

.

or Reject Change/Delete Comment

.

, and then click Accept All Changes in Document to accept

them all.
•

Click the arrow next to Reject Change/Delete Comment to

reject all changes or delete all comments

at once.
•

To select or clear the check boxes for all reviewers in the list, click All Reviewers.
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12 Work Offline
Objectives:
By the end of this section you will be able to:
•

Set up offline folders

•

Set-up dial-up networking

•

Synchronise the folders
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Work Offline

Working offline gives you access to your information regardless of whether you are connected to your e-mail server. For
example, laptop users can work with their e-mail, even when not connected to the e-mail server.

12.2

Remote Mail

If you only need to download messages from your Exchange Server Inbox, use the Remote Mail feature. Remote Mail makes
it possible for you to screen out the messages you don’t want to download by first downloading the message headers and
then deciding which ones you want to download the complete messages for. This way you can screen out messages that
are less urgent, which is especially useful when you’re away from the office and your connection speed or cost is a concern.

12.3

Offline folders

Unlike with Remote Mail, with offline folders you’re not restricted to working with only the Inbox. Offline folders make
it possible to take a folder from a server location, work with the contents of the folder when you are not connected to
the network, and then update the folder and its corresponding server folder to make the contents of both identical. This
process is called synchronizing folders.
You can add, delete, and modify the contents of an offline folder exactly as you can with a folder on a server. For example,
you can change and move items in your offline Inbox, send messages that are placed in your offline Outbox, and read your
offline public folders. Meanwhile, you will receive new messages in your Inbox on the server, and other users might add,
delete, and change items in public folders. But you will not be aware of these changes on the server until you synchronize.
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Offline folders are stored in the Offline Folder (.ost) file. This file is located on your computer hard disk and is available
even when the network is down. The .ost file can be compacted to save space on your computer.

12.4

Work offline using Exchange Server

The way in which you set up to work offline the first time depends on the type of e-mail server that you use.

)To set up offline folders:
Mouse

•

On the Tools menu, click E-Mail Accounts, click View or change existing e-mail accounts, and then click
Next.

•

In the Outlook processes e-mail for these accounts in the following order list, click Microsoft Exchange
Server, and then click Change.

•

Click More Settings.

•

Click the Advanced tab, and then click Offline Folder File Settings.

•

In the File box, type the path to the file you want to use as the Offline Folder file (offline folder file: The file
on your hard disk that contains offline folders. The offline folder file has an .ost extension. You can create it
automatically when you set up Outlook, or when you first make a folder available offline.).

•

The default file name is outlook.ost. If this file already exists, you are prompted for a new name.

•

Work as you normally do. Sent items (item: An item is the basic element that holds information in Outlook
(similar to a file in other programs). Items include e-mail messages, appointments, contacts, tasks, journal
entries, notes, and posted items and documents.) remain in your Outbox.

Synchronise the folders.
You can automatically synchronise your offline folders at a time or time intervals that you specify, or you can manually
synchronise them whenever you need to. Whether you synchronise automatically or manually, you must first have specified
the folders for offline use.

Set up dial-up networking
If you are using dial-up networking to work with offline folders from a remote location, you must first set up your computer
with a modem, a telephone line, and dial-up networking software.

)To set up your computer for dial-up networking
Menu

•

On the Tools menu, click E-Mail Accounts, click View or change existing e-mail accounts, and then click
Next.

•

In the list, click Microsoft Exchange Server, and then click Change.

•

Click More Settings.

•

Click the Connection tab, and then click Connect using my phone line.

•

Under Modem, click the appropriate dial-up connection in the list, or click Add and follow the instructions
in the wizard to create a new connection.
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Specify the folders you want to be available for offline use.
The Inbox, Outbox, Deleted Items, Sent Items, Calendar, Contacts, Tasks, Journal, Notes, and Drafts folders are
automatically made available offline when you set up offline folders. To use any other folder offline, you must specifically
enable it for offline use by following the steps below.

)To specify the folders for offline use:
Menu

•

On the Tools menu, point to Send/Receive Settings, and then click Define Send/Receive Groups.

•

In the list, click a Send/Receive group containing an Exchange Server account, and then click Edit.

•

Under Accounts, select your Exchange Server account.

•

In the list, select the folders that you want to use offline in addition to your default folders.

•

If you want to apply a filter to a specific folder, click the folder, click Filter Selected Folder, and then select
the options that you want.

•

If you want to limit the size of messages to download when you synchronise folders, click Limit Message
Size, and then click the options that you want.

)

• Click OK.
To stop using a folder offline:

Menu
•

On the Tools menu, point to Send/Receive Settings, and then click Define Send/Receive Groups.

•

In the list, click the group that contains the accounts and folders you want to make unavailable offline, and
then click Edit.

•

In the list, clear the check box next to the folder that you want to make unavailable for offline use.

If the folder you want to make unavailable for offline use contains subfolders that are available for offline use, those
subfolders remain available unless you clear the check boxes next to them.

Synchronise folders manually

)To synchronise the selected folder:
Menu

•

Click the Tools menu, point to Send/Receive, and then click This Folder.

)To synchronise all of your folders that are set up for offline use:
Menu

•

Click the Tools menu, point to Send/Receive, and then click Send and Receive All.

•

To synchronise a Send/Receive group of folders, click the Tools menu, point to Send/Receive, and then click
the name of the Send/Receive group.

Download free eBooks at bookboon.com

114

Outlook 2003: Part II

Work Offline

Synchronise folders automatically

)To set up online synchronisation:
Menu

•

On the Tools menu, point to Send/Receive Settings, and then click Define Send/Receive Groups.

•

In the list, click a group.

•

Under When Outlook is online, select the check boxes that you want

•

To automatically synchronise all folders at specified intervals while you’re online, select the Schedule an
automatic send/receive every [x] minutes check box, and then enter a number between 1 and 1440.

•

To synchronise all folders after every online Microsoft Outlook session, select the Perform an automatic
send/receive when exiting check box.

)To set up offline synchronisation:
Menu

•

On the Tools menu, point to Send/Receive Settings, and then click Define Send/Receive Groups.

•

In the list, click a group.

•

Under When Outlook is offline, select the check boxes that you want:

•

To automatically synchronise all folders at specified intervals while you’re online, select the Schedule an
automatic send/receive every [x] minutes check box, and then enter a number between 1 and 1440.

If you are using a POP3, IMAP, or HTTP e-mail server, you may switch between working online and offline at any time
by clicking Work Offline on the File menu.
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